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Tutorial Highlights 

ª Provides a brief introduction to Eclipse 
ª Shows how to import existing code into Eclipse 
ª Shows how to build and run an MPI application 
ª Shows features of PE Developer Environment: 

ª Monitoring hardware performance counters 
ª Profiling/tracing and MPI application 
ª Profiling I/O activity in an application 

ª Shows debugging with the IBM Parallel 
Debugger 



Tutorial Outline 
Time Module Topics 

13:30 – 14:00 1. Overview of Eclipse and 
PTP 

ª  Introduction to Eclipse/PTP 
ª  Installation of Parallel Package 

14:00 – 15:00 2. Eclipse Basics ª  Importing a project 
ª  Editing, building, launching 
ª  Working with MPI, Fortran 

15:00 – 15:30 Break 

15:30 – 16:00 3. Advanced Features ª  Target system configurations 
ª  Advanced development and refactoring 

16:00 – 16:30 4. IBM HPC Toolkit ª  Profile application using Xprof 
ª  Hardware performance counters 
ª  MPI Profiling and Tracing 

16:30 – 16:55 5. IBM Parallel Debugger ª  Overview of features  
ª  Hands-on workshop exercises 

16:55 – 17:00 6. Wrap-up 
 

ª  Overview of features not covered 
ª  Resources, getting questions answered 
ª  How to participate 
ª  Participant feedback 



Installation 

ª Objective 
ª To learn how to install Eclipse and PTP 

ª Contents 
ª System Prerequisites 
ª Download and Install Eclipse 
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System Prerequisites 
ª Local system (running Eclipse) 

ª Linux (just about any version) 
ª MacOSX (10.5 Leopard or higher) 
ª Windows (XP on) 

ª Java: Eclipse requires Sun or IBM Java 
ª Only need Java runtime environment (JRE) 
ª Java 1.6 or higher  

ª Java 1.6 is the same as JRE 6.0 
ª The GNU Java Compiler (GCJ), which comes 

standard on Linux, will not work! 
ª OpenJDK, distributed with some Linux distributions, 

has not been tested by us but should work. 
ª See http://wiki.eclipse.org/PTP/installjava 
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Eclipse Packages 
ª The current version of Eclipse (4.2) is also 

known as “Juno” 
ª Next release “Kepler” in June 2013 

ª Eclipse is available in a number of different 
packages for different kinds of development 
ª http://eclipse.org/downloads 

ª For PTP, we recommend the all-in-one 
download: 
ª Eclipse for Parallel Application Developers 

 
 
 
 
We often call this the “Parallel Package” 
 
 
 

 
 

Install-2 Installation 



Pre-release Package 
ª For this tutorial we will be using a pre-release 

version of Eclipse “Kepler” 
ª This version will be released at the end of June 
ª The Parallel Package is available from the 

“Developer Builds” link on the main downloads 
page 
ª http://eclipse.org/downloads 
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Exercise 

1.  Go to the “Developer Builds” page of the main Eclipse 
download site 

2.  Download the “Eclipse for Parallel Application 
Developers” package to your laptop 
ª  Your tutorial instructions will provide the location of the 

package 
ª  Make sure you match the architecture with that of your 

laptop 
3.  If your machine is Linux or Mac OS X, untar the file 

ª  On Mac OS X you can just double-click in the Finder 
4.  If your machine is Windows, unzip the file 
5.  This creates an eclipse folder containing the 

executable as well as other support files and folders 
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Starting Eclipse 
ª  Linux 

ª  From a terminal window, enter 
“<eclipse_installation_path>/eclipse/eclipse &” 
 

ª  Mac OS X 
ª  From finder, open the eclipse folder where you installed 
ª Double-click on the Eclipse application 
ª Or from a terminal window 

 
ª  Windows 

ª Open the eclipse folder 
ª Double-click on the eclipse executable 
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ª Eclipse prompts for a workspace location at 
startup time 

ª The workspace contains all user-defined data 
ª Projects and resources such as folders and files 
ª The default workspace location is fine for this tutorial 

Specifying A Workspace 

The prompt can be 
turned off 
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Eclipse Welcome Page 

ª Displayed when Eclipse is run for the first time 
Select “Go to the workbench” 

Install-7 
Installation 



Intro-0 Introduction 

Introduction 

ª Objective 
ª To introduce the Eclipse platform and PTP 

ª Contents 
ª New and Improved Features 
ª What is Eclipse?  
ª What is PTP? 



Intro-1 

What is Eclipse? 

ª A vendor-neutral open-source workbench for 
multi-language development 

ª A extensible platform for tool integration 
ª Plug-in based framework to create, integrate 

and utilize software tools 

Introduction 
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Eclipse Features 

ª Full development lifecycle support 
ª Revision control integration (CVS, SVN, Git) 
ª Project dependency management 
ª Incremental building 
ª Content assistance 
ª Context sensitive help 
ª Language sensitive searching 
ª Multi-language support 
ª Debugging 

Introduction 
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Parallel Tools Platform (PTP) 

ª  The Parallel Tools Platform aims to provide a highly 
integrated environment specifically designed for parallel 
application development 

ª  Features include: 
ª  An integrated development environment (IDE) that 

supports a wide range of parallel architectures and runtime 
systems 

ª  A scalable parallel debugger 
ª  Parallel programming tools  

(MPI, OpenMP, UPC, etc.) 
ª  Support for the integration  

of parallel tools 
ª  An environment that simplifies the  

end-user interaction with parallel systems 
ª  http://www.eclipse.org/ptp 

Introduction 



Eclipse PTP Family of Tools 
Coding & Analysis 

(C, C++, Fortran) 

Parallel Debugging 

Launching & 
Monitoring 

Performance Tuning 
(TAU, HPCT, …) Intro-4 Introduction 



How Eclipse is Used 
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Remote 
Source 
Code 

Introduction 

Local 
Source 
Code 

Edit/Build 

Launch/Monitor 

Debugging 

Performance Tuning 



Base Tools Platform 

Eclipse Platform (4.3) 
C/C++ Development Tools 
(CDT 8.2) 
Fortran Development Tools 
(Photran 8.1) 
Linux Tools 
 

Parallel Tools 
Platform 

Scalable Communication Infrastructure (SCI) 

POE Runtime 

Programming models HPC Toolkit 

•  PTP 7.0 
•  Parallel Language 

Development Tools 
•  Parallel application launch 
•  System monitoring 
•  Synchronized projects 
•  Remote projects 
•  External Tools Framework 
•  LSF Support 

•  MPI profiling 
•  OpenMP profiling* 
•  Hardware counter profiling 
•  I/O profiling 
•  Profiling and trace 

visualization 
•  Binary instrumentation* 

•  MPI 
•  LAPI 
•  PAMI 
•  UPC 
•  OpenMP 
•  OpenSHMEM 

Open MPI  
MPICH2 

PBS/Torque  
SLURM 

Grid Engine 

LoadLeveler 

Parallel Environment Developer Edition 1.3 
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Importing a Project 
ª Objective 

ª Learn how to import a project into Eclipse 
ª Learn how to manage synchronized projects 

ª Contents 
ª Eclipse project locations 
ª Creating a synchronized project 
ª Managing synchronized project properties 
ª Using synchronize filters 

Synchronized Projects Sync-0 



Project Location 
ª Local 

ª Source is located on local machine, builds happen locally 
ª This is the default Eclipse model 

ª Synchronized 
ª Source is located on both local and remote machine(s), 

then kept in synchronization by Eclipse 
ª Building and launching happens remotely 

(can also happen locally) 
ª Used mainly for scientific and supercomputing 

applications 
ª There are also remote-only projects, but these 

have limitations and are not covered here 

Synchronized Projects Sync-1 
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Synchronized Projects 
ª  Projects types can be: 

-2 

File	
  Service	
   Index	
  Service	
  

Launch	
  Service	
  

Build	
  Service	
  

Debug	
  Service	
  

Local	
  source	
  
code	
  copy	
  

Remote	
  source	
  
code	
  copy	
  

Local	
   Remote	
  

Run	
  

Debug
	
  

Compute	
  

Edit	
   Search/Index	
  
NavigaAon	
  

Synchronize	
  

Executable	
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Revision Control Systems (RCS) 
ª Eclipse supports a range of RCS, such as CVS, 

Git, and Subversion (and others) 
ª These are distinct from synchronized projects 
ª RCS can be used in conjunction with synchronized 

projects 
ª Synchronized projects are typically not used for 

revision control 

Synchronized Projects Sync-3 
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Synchronized Project Creation 

ª Local -> Remote 
ª Projects start out local then are synchronized to a 

remote machine 
ª Three options 

ª Created from scratch 
ª Imported from local filesystem 
ª Imported from RCS 

ª Remote -> Local 
ª Projects start out on remote machine then are 

synchronized to the local system 
ª Two options 

ª Already on remote system 
ª Checked out from RCS 
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Source Code for project 

ª Source code exists on remote target  
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Create Synchronized Project 

ª  In the Project Explorer, right click then choose 
ª  New>Synchronized C/C++ Project if your project is C/C++ only 

ª  New>Synchronized Fortran Project if your project contains Fortran 
files 

ª  This adds a Fortran nature so you can access Fortran properties, etc. 
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ª  Enter the Project Name 
ª  E.g. “shallow” 

ª  The Local Directory specifies 
where the local files are located 
ª  Leave as default 

ª  The Remote Directory specifies 
where the remote files are located 
ª  Select a connection to the remote 

machine, or click on New… to create 
a new one 
  (See next slide) 

ª  Browse for the directory on the 
remote machine 

ª  Use Modify File Filtering… if required 
(see later slide) 

 

New Synchronized Project Wizard 



Creating a Connection 

ª  In the Target Environment 
Configuration dialog 
ª  Enter a Target name for the 

remote host 
ª  Enter host name, user name, 

and user password or other 
credentials 

ª  Select Finish 

Sync-8 Synchronized Projects 
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ª  Choose the Project Type 
ª  If you are synchronizing with an  

existing project, use Makefile 
Project>Empty Project 

ª  Otherwise, choose the type of project 
you want to create 

ª  Choose the toolchain for the remote 
build 
ª  Use a toolchain that most closely 

matches the remote system 

ª  Choose a toolchain for the local 
build 
ª  This is used for advanced editing/

searching   

ª  Click Finish to create the project 

Project Type & Toolchain 

Synchronized Projects 



Synchronized Project Menu 
ª  Synchronized projects are indicated 

with a “synchronized” icon 
ª  Right click on project to access 

Synchronize menu 
ª  Sync Active Now will manually 

synchronize the active configuration 
ª  Set Active can be used to select the 

active configuration 
ª  Manage… is used to create new 

configurations to synchronize to 
different target systems 

ª  Sync All Now will manually 
synchronizes all configurations 

Sync-10 Synchronized Projects 

ª  Auto-Sync (Global) will enable or 
disable automatic synchronization 

ª  Auto-Sync Settings can be used to 
select which configurations will be 
synchronized 

ª  Filter… is used to change the filter 
settings for the project 



Manage Configurations 
ª  Used to manage synchronize 

configurations 
ª  Use Set Active to change the active 

configuration (shown in bold in the 
list of configurations) 

ª  Use Add to add a new configuration in 
order to synchronize to a different 
target system 

ª  Other configuration information, such 
as the default build configuration, can 
also be changed 

 

Sync-11 Synchronized Projects 

By default, there will be a configuration for the 
target system (active) and a Local configuration. 
The Local configuration can be used to build a 
local copy of the project if desired. 



Synchronize Filters 

ª If not all files in the remote project should be 
synchronized, a filter can be set up 
ª For example, it may not be desirable to synchronize 

binary files, or large data files 
ª Filters can be created at the same time as the 

project is created 
ª Click on the Modify File Filtering… button in the 

New Project wizard 
ª Filters can be added later 

ª Right click on the project and select 
Synchronizee>Filter… 
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Synchronize Filter Dialog 

ª  Files can be filtered individually 
by selecting/unselecting them in 
the File View 

ª  Include or exclude files based on 
ª  Paths 
ª  Regular expressions 
ª Wildcards (foo.*) 
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Synchronized Project Properties 
ª  Synchronized configurations 

can also be managed through 
the project properties 

ª  Open the project properties 
by right-clicking on the 
project and selecting 
Properties 
ª  Select Synchronize 

ª  This is the same as using the 
Synchronize>Manage… 
menu 
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Forcing a Resync 
ª  If Auto-sync is set, the project 

should automatically resync with 
remote system when things 
change 

ª  Sometimes you may need to  
do it explicitly 

ª  Right click on project and select 
Synchronization>Sync Active 
Now 
 

ª  Status area in lower right shows 
when Synchronization occurs 
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Remote Terminal 
ª  There is a remote terminal that 

can be used to provide a shell from 
within Eclipse 

ª  Select Window>Show 
View>Other… 

ª  Choose Terminal from the 
Terminal folder 

ª  In the Terminal view, click on the 
New Terminal Connection 
button 

ª  Choose a previously configured 
connection from the dropdown, or 
create a new one 
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ª  If you need to change remote connection 
information (such as username or 
password), use the Remote 
Environments view  
 

Changing Remote Connection Information 

Sync-17 

ª  Stop the remote 
connection first 

ª  Right-click and 
select Edit ª  Note: Remote Host may be stopped 

ª  Any remote interaction starts it 
ª No need to restart it explicitly 

Synchronized Projects 



Exercise 
1.  Import an existing project into a synchronized 

project 
ª  Your login information and source directory will be 

provided by the tutorial instructor 
2.  Observe that the project files are copied to your 

workspace 
3.  Open a file in an editor, add a comment, and 

save the file 
4.  Observe that the file is synchronized when you 

save the file 
ª  Watch lower-right status area; confirm on host system 
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Optional Exercise 
1.  Experiment with sync filters  

ª  Create a filter to exclude files ending in “.o” 
ª  Create an empty file ending in “.o” on the local system 

and verify it is not copied to remote machine after a 
sync 

ª  Try creating a file on the remote system and verify 
that it is not copied 

2.  Create a new synchronize configuration 
ª  Use the same host, different directory 
ª  Synchronize the new configuration and verify that you 

have a second copy on the remote machine 
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Building a Project 

ª Objective 
ª Learn how to build an MPI program on a remote 

system 
ª Contents 

ª How to change build settings  
ª How to start a build and view build output 
ª How to clean and rebuild a project 
ª How to create build targets 

Build-0 Building a Project 



Build Configurations 
ª  A build configuration provides the 

necessary information to build the 
project 

ª  The build configuration 
information is specified in the 
project properties 

ª  Projects can have multiple build 
configurations, each configuration 
specifies a different set of options 
for a build 

ª  Open the properties by right-
clicking on the project name in the 
Project Explorer view and 
selecting Properties (bottom of 
the context menu list) 

Build-1 Building a Project 

Note: Fortran projects are a superset of 
C/C++ projects, so they have properties 
for both 



Build Properties (1) 

Build-2 Building a Project 

ª  C/C++ Build 
ª  Main properties page 
ª  Configure the build command 
ª  Default is “make” but this can be changed to 

anything 
ª  Build Variables 

ª  Create/manage variables that can be used in other 
build configuration pages 

ª  Discovery Options 
ª  Obsolete options page for discovering compiler 

settings (use C/C++ General>Preprocessor 
Include Paths instead) 

ª  Environment 
ª  Modify/add environment variables passed to build 

ª  Logging 
ª  Enable/disable build logging 



Build Properties (2) 

Build-3 Building a Project 

ª  Settings 
ª  Binary parser selection (used to display binaries in 

Project Explorer) 
ª  Error parser selection (used to parse the output 

from compiler commands) 
ª  Tool Chain settings (managed projects only) 

ª  Tool Chain Editor 
ª  Allows the tools in a particular tool chain to be 

modified 
ª  XL C/C++ Compiler 

ª  Compiler settings for XL C/C++ compilers (if 
installed) 



Selecting Build Configuration 

ª  Multiple build configurations may be available 
ª  Synchronized projects will usually have a remote and a local build configuration 
ª  Build configurations for different architectures 

ª  The active build configuration will be used when the build button 
is selected 

ª  The Build Configurations project context menu can be used to 
change the active configuration 
ª  Right click on project, then select the build configuration from the Build 

Configurations > Set Active menu  

Build-4 Building a Project 



Building Synchronized Projects 
ª  When the build button is selected, the 

“active” build configuration will be built 
on the remote system specified by the 
“active” synchronize configuration 

ª  The build and synchronize configurations 
are independent 
ª  It is possible to change which build 

configuration is active, but make sure this 
makes sense on the remote system specified in 
the synchronize configuration  

ª  A build configuration can be associated 
with a synchronize configuration, so that 
it is automatically selected when the 
synchronize configuration is changed 
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Configuring the Build Environment 
ª  If the remote system has an 

environment system (such as 
Modules) installed, a custom 
set of modules can be 
configured for building C/C++ 
projects 

ª  In the Manage Synchronize 
Configurations dialog, select 
the configuration you wish to 
change 

ª  Check Use an environment 
management system to 
customize the remote build 
environment 
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Build Environment (2) 
ª  Select a module from the 

Available Modules list and 
click the Add-> button to add 
them to the Selected 
Modules list 

ª  Use the <-Remove button to 
remove modules from the 
Selected Modules list 

ª  Use the Filter list field to 
quickly find modules with a 
given name 

ª  Use the Up and Down 
buttons to change the order of 
the Selected Modules 

ª  Click Select Defaults to load 
only those modules that are 
present in a new login shell 
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Build Environment (3) 

ª  To build the project, Eclipse will 
ª  Open a new Bash login shell 
ª  Execute module purge 
ª  Execute module load for each selected module 
ª  Run make 

ª  Module commands are displayed in the Console view during build 
ª  Beware of modules that must be loaded in a particular order, or 

that contain common paths like /bin or /usr/bin 
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Build Environment (4) 

ª  For this tutorial, we want to use gcc and Open MPI 
ª  Navigate to gnu/4.1.2 in Available Modules and select Add -> 
ª  Navigate to openmpi/1.4.3 and select Add -> 
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Starting the Build 
ª  Select the project in Project Explorer 

ª  Click on the     hammer button in toolbar to run a build 
using the active build configuration 
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ª  Build output will be visible in console 

Viewing the Build Output 
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Build Problems 

ª  Build problems will be 
shown in a variety of 
ways 
ª  Marker on file 
ª  Marker on editor line 
ª  Line is highlighted 
ª  Marker on overview ruler 
ª  Listed in the Problems 

view  
 

ª  Double-click on line in 
Problems view to go 
to location of error in 
the editor 
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Forcing a Rebuild 
ª  If no changes have been made,  

make doesn’t think a build is needed 
e.g. if you only change the Makefile 
 

ª  In Project Explorer, right click on 
project and select Clean Project 
 

ª  Build console will display results of 
clean 

 
 

ª  Rebuild project by clicking on  
build button again 
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ª  By default 
ª  The build button will run “make all” 
ª  Cleaning a project will run “make clean” 

ª  Sometimes, other build targets are 
required 

ª  Open Make Target view 
ª  Select project and click on New 

Make Target button 
ª  Enter new target name 
ª  Modify build command if desired 
ª  New target will appear in view 
ª  Double click on target to activate 

Creating Make Targets 

Build-14 Building a Project 
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Exercise 

1.  Start with your ‘shallow’ project 
2.  Set the gnu/4.1.2 and openmpi/1.4.3 modules 
3.  Build the project 
4.  Edit a source file and introduce a compile error 

ª  In main.c, line 97, change ‘;’ to ‘:’ 
ª  Save, rebuild, and watch the Console view 
ª  Use the Problems view to locate the error 
ª  Locate the error in the source code by double 

clicking on the error in the Problems view 
ª  Fix the error 

5.  Rebuild the project and verify there are no build errors 

Building a Project 
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Optional Exercises 

1.  Open the Makefile in Eclipse.  Note the line starting with 
“tags:” – this defines a make target named tags. 

2.  Open the Outline view while the Makefile is open.  What icon 
is used to denote make targets in the Outline? 

3.  Right-click the tags entry in the Outline view.  Add a Make 
Target for tags. 

4.  Open the Make Targets view, and build the tags target. 
 

Building a Project 

1.  Rename Makefile to Makefile.mk 
2.  Attempt to build the project; it will fail 
3.  In the project properties (under the C/C++ Build category), 

change the build command to:  make –f Makefile.mk 
4.  Build the project; it should succeed 



Running an Application 
ª Objective 

ª Learn how to run an MPI program on a remote system 

ª Contents 
ª Creating a run configuration 
ª Configuring the application run 
ª Monitoring the system and jobs 
ª Controlling jobs 
ª Obtaining job output 

Running an Application Run-0 



Run-1 

ª  Open the run configuration  
dialog Run>Run 
Configurations… 

ª  Select Parallel Application 
ª  Select the New button 

 
Or, just double-click on  
Parallel Application 
to create a new one  

Creating a Run Configuration 

Note: We use “Launch Configuration” as a generic term to refer to either a 
“Run Configuration” or a “Debug Configuration”, which is used for debugging. 

Running an Application 
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Set Run Configuration Name 
ª  Enter a name for this run configuration 

ª  E.g. “shallow” 

ª  This allows you to easily re-run the 
same application 

ª  If the “shallow” project was selected 
when the dialog was opened, its name 
will be automatically entered 

-2 Running an Application 



Run-3 

Configuring the Target System 
ª  In Resources tab, select a 

Target System Configuration 
that corresponds to your target 
system 
ª  Use edu.sdsc.trestles.torque.batch 

ª  Target system configurations 
can be generic or can be specific 
to a particular system 

ª  Use the specific configuration if 
available, or the generic 
configuration that most closely 
matches your system 

ª  You can type text in the box to 
filter the configurations in the 
list 

-3 Running an Application 
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Configure the Connection 
ª  Choose a connection to 

use to communicate with 
the target system 

ª  If no connection has been 
configured, click on the 
New button to create a 
new one 
ª  Fill in connection information, 

then click ok 

ª  The new connection 
should appear in the 
dropdown list 

ª  Select the connection you 
already have to 
trestles.sdsc.edu 

ª  Select toggle if you don’t 
want to see popup again 
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Resources Tab 
ª  The content of the 

Resources tab will vary 
depending on the target 
system configuration 
selected  

ª  This example shows the 
TORQUE configuration 

ª  For TORQUE, you will 
normally need to select 
the Queue and the 
Number of nodes 

ª  For parallel jobs, choose 
the MPI Command and 
the MPI Number of 
Processes 
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Resources Tab (2) 
ª  For this tutorial, use the following values 

ª  Queue: shared 
ª  Number of nodes: 1:ppn=5 
ª  MPI Command: mpirun 
ª  MPI Number of Processes: 5 
ª  Leave other fields alone 

ª  Configure modules for running the application 
ª  Click on the Modules to Load: Configure… button 
ª  Select the same modules used to build 

ª  gnu/4.1.2 
ª  openmpi/1.4.3 
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Viewing the Job Script 
ª  Some target 

configurations will 
provide a View Script  
button 

ª  Click on this to view the 
job script that will be 
submitted to the job 
scheduler 

ª  Batch scheduler 
configurations should 
also provide a means of 
importing a batch script 
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Application Tab 

ª  Select the Application tab 
ª  Choose the Application 

program by clicking the 
Browse button and locating 
the executable on the remote 
machine  
ª  Use the same “shallow” 

executable 
ª  Select Display output from 

all processes in a console 
view 
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Arguments Tab (Optional) 
ª  The Arguments tab lets 

you supply command-line 
arguments to the 
application  

ª  You can also change the 
default working directory 
when the application 
executes 
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Environment Tab (Optional) 
ª  The Environment tab 

lets you set environment 
variables that are passed 
to the job submission 
command 

ª  This is independent of the 
Environment Management 
(module/softenv) support 
described in a separate 
module 
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Synchronize Tab (Optional) 
ª  The Synchronize tab lets 

you specify upload/
download rules that are 
execute prior to, and after 
the job execution 

ª  Click on the New 
upload/download rule 
buttons to define rules 

ª  The rule defines which file 
will be uploaded/
downloaded and where it 
will be put 

ª  Can be used in 
conjunction with program 
arguments to supply input 
data to the application 
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Common Tab (Optional) 
ª  The Common tab is 

available for most launch 
configuration types (not 
just Parallel Application) 

ª  Allows the launch 
configuration to be 
exported to an external 
file 

ª  Can add the launch 
configuration to the 
favorites menu, which is 
available on the main 
Eclipse toolbar 
 
 

ª  Select Run to launch 
the job 
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Run 

ª Select Run to launch the job 
ª You may be asked to switch to the System 

Monitoring Perspective 
 
 
 
 
 

ª Select Remember my decision so you 
won’t be asked again 

ª Select Yes to switch and launch the job 
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System Monitoring Perspective 
ª  System view 

ª  Jobs running 
on system 

ª  Active jobs 

ª  Inactive jobs 

ª  Messages 
 

ª  Console  
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Moving views 

ª The System Monitoring Perspective overlaps 
the Active Jobs and Inactive Jobs views 

ª To split them apart and see both at once,  
drag the tab for the Inactive Jobs view to 
the lower half of its area, and let go of mouse 
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System Monitoring 

ª  System view, with 
abstraction of system 
configuration 
 

ª  Hold mouse button 
down on a job in 
Active Jobs view to 
see where it is 
running in System 
view 

ª  Hover over node in 
System view to see 
job running on node 
in Active Jobs view 
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One node with 
16 cores 
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ª  Job initially appears in 
Inactive Jobs view 

ª  Moves to the Active Jobs 
view when execution begings 

ª  Returns to Inactive Jobs 
view on completion 

ª  Status refreshes  
automatically every 60 sec 

ª  Can force refresh with menu 
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ª  Right click on a job to open 
context menu 

ª  Actions will be enabled IFF 
ª  The job belongs to you 
ª  The action is available on the 

target system 
ª  The job is in the correct state for 

the action 
 

ª  When job has COMPLETED, it 
will remain in the Inactive 
Jobs view 
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ª  After status changes to 
COMPLETED, the output is 
available 
ª  Right-click on the job  
ª  Select Get Job Output to display 

output sent to standard output 
ª  Select Get Job Error to retrieve 

output sent to standard error 
 

ª  Output/Error info shows in 
Console View 
 

ª  Jobs can be removed by 
selecting Remove Job Entry 
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Add a Monitor 

ª You can monitor other systems too 
ª In Monitors view, select the ‘+’ button to 

add a monitor 
 
 
 

ª Choose monitor type and connection; 
create a new connection if necessary 

Run-20 Running an Application 

Double click 
new monitor 
to start 
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Exercise 

1.  Start with your ‘shallow’ project 
2.  Create a run configuration 
3.  Complete the Resources tab 
4.  Select the executable in the Application tab 
5.  Submit the job 
6.  Check the job is visible in the Inactive Jobs view, 

moves to the Active Jobs view when it starts running 
(although it may be too quick to show up there), then 
moves back to the Inactive Jobs view when completed 

7.  View the job output 
8.  Remove the job from the Inactive Jobs view 

Running an Application 
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HPC Toolkit 
ª  Objective 

ª  Learn how to use the 
HPC Toolkit to analyze 
the performance of 
your applications 

ª  Contents 
ª  Introduction 
ª  Application CPU 

Profiling using Xprof 
ª  Profiling using 

hardware performance 
counters 

ª MPI profiling and 
tracing 

HPC Toolkit HPCT-0 

Update May 2013 
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What is HPC Toolkit? 

HPCT-1 

ª Set of performance tools integrated with 
Eclipse and PTP 
ª Hardware performance counter profiling 
ª MPI profiling and tracing 
ª OpenMP profiling 
ª I/O profiling and tracing 

ª Application CPU profiling 
ª Binary instrumentation tools 
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Hardware Performance Counters 
ª  Helps identify problem 

code areas 
ª  Excessive CPU 

resource usage 
ª  Collects hardware 

performance counter 
event counts 

ª  Reports hardware 
performance counters 
for functions, blocks 

ª  View multiple tasks 
ª  Sort/filter data 
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MPI Profiling and Tracing 
ª  Profiles MPI calls 

ª  Time spent 
ª Number of calls 
ª Message sizes 

ª  Traces MPI calls 
ª  Traces individual MPI 

calls 
ª  Identifies 

communication 
patterns 

ª  Time spent/message 
size per MPI call 
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OpenMP Profiling 
ª  Profiles OpenMP 

programs 
ª  Time spent in parallel 

region 
ª  Time waiting for 

barriers 
ª Number of invocations 

of parallel region 
ª  Identify load 

imbalances across 
threads 
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I/O Profiling and Tracing 
ª  Profiles I/O system 

calls 
ª  Time spent 
ª Number of calls 
ª  Bytes per I/O 

ª  Traces I/O calls 
ª  Traces individual I/O 

system calls 
ª  Statistics about I/O 
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Binary Instrumentation 

Module 7 7-6 

Instrumentation 

Visualization 

Analysis 

Action Point Binary  

Instrumentation 

Symbolic Binary  

Instrumentation 

Action Point  
List 

 
 
 
 

inst 

Runtime 
lib 

Visualization 

XML Symb. 
Descr. 

Libn Lib1 

a.out src 
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Using HPC Toolkit 
Possible workflow 

ª  Compile – in preparation for profiling (-pg option) 
ª  Run - to generate gmon.out files 
ª  Run Xprof to determine ‘hot’ functions in application 

 
ª  Instrument ‘hot’ functions in application for 

performance data gathering 
ª  Hardware Performance Counters, MPI, OpenMP, I/O 

ª  Run the instrumented application 
ª  Analyze application performance with  

HPC Toolkit tools 
 

ª  Correct performance problems  
… and repeat 
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Application CPU Profiling 
ª  Profiles entire 

application 
ª  Shows time spent in 

each function 
ª  Easily identify highest 

CPU usage 
ª  Shows proportion of 

time in caller and 
callee 

ª  Additional views and 
reports for more detail 
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Compiling the Application 
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Compilation Requirements 
ª Compile flags for Hardware performance 

counters, MPI, OpenMP and I/O profiling 
ª AIX: –g 
ª Linux: --emit-stub-syms -Wl,--hash-style=sysv -g 

ª Compile flags for CPU profiling with Xprof 
ª AIX and Linux: Application must be compiled and 

linked with -g and –pg flags 
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Xprof (CPU Profiling) 
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Xprof and Remote Systems 
ª  Xprof not yet integrated with Eclipse 
ª  Useful tool for getting overview of application 

performance 
ª  Xprof must be run on remote AIX or Linux system 
ª  Application can be run on remote system 
ª  Application can also be run using PTP  
ª  Tutorial fragment explains how to run on remote system 
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Set Up Makefile (Xprof) 
ª  Makefile should look like following view (shows AIX) 

ª  Should have all and clean targets 
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Build the Application 
ª  Make source code changes and 

save 
ª  Right click project name in 

Project Explorer view 
ª  Click Build Project in popup 

menu 
ª Or select project and use 

hammer icon in toolbar  
ª  Force build by clicking Clean 

Project then Build Project in 
popup menu 
ª Or Menu:  Project � Clean…. 
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Build the Application 2 
ª  Project Explorer updates to 

show new files 
ª  Console view shows build log 
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Log on Login Node 
ª  Open xterm on local machine 
ª  ssh w/X11 tunneling to login node (2 hops) 
ª  ssh tunneling for X11 must be enabled (by admins) 
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Set Up and Run Application 
 
ª  Set PE environment variables 
ª  Run application 
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Display results using Xprof 
ª  Set up HPC Toolkit environment (env.sh) 
ª  Invoke Xprof with executable and gmon.out files 
ª  Can specify multiple gmon.out files  
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Xprof Initial View 
ª  Large green box for 

executable and each 
shared library (AIX) 

ª  Nodes represent 
functions, lines 
represent caller/callee 
relationship 

ª  Size of block 
representative of time 
in function 
ª Width: Function & all 

of its callees 
ª Height: Function only 
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Expand Application Tree 
ª  Right click on outer 

green box 
ª  Click Remove Cluster 

Box in popup menu 
ª  Left click on nodes 

(boxes) to see function 
detail 

ª  Left click on arcs to see 
caller/callee details 

ª  Right click node or arc 
for additional actions 

ª  Use View menu to 
zoom 

ª  Use scrollbars to scroll 
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Filter Call Graph 
ª  Click on Filter menu 
ª  Click on Filter by CPU 

Time 
ª  Drag slider to desired 

number of functions 
ª  Lowest time functions 

filtered out 
ª  Additional filters 

ª  Call counts 
ª  Function name 

ª  Click Show Entire Call 
Tree to restore 
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Call Graph Profile Report 
ª  Click on Report menu 
ª  Click on Call Graph 

Profile 
ª  Report shows  

ª  Time spent in function 
and descendants 

ª Number of times a 
function was called 
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Hardware Performance Counter 
Profiling 
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Rebuild Application 
ª  Update Makefile to use correct compile/link flags (shows Linux) 

ª  CFLAGS = -g -pg -q64 
ª  HFLAGS = -Wl,--emit-stub-syms -Wl,--hash-style=sysv 

ª  Rebuild application using Project->Clean Project then  
Project->Build Project 
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Set up Profile Configuration 
ª  Select Run in main menu 
ª  Select Profile Configurations in menu 
ª  Assuming you already have a configuration for ‘shallow’ … 
ª  Select existing run configuration from Parallel Application tab 
ª  Make changes on following pages as needed 
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Set up Profile Configuration 2 
ª  Launch config information from previous run 
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Set up Profile Configuration 3 
ª  Switch to Performance Analysis tab 
ª  If not already set, Select Tool: HPC Toolkit 

Wait while the 
executable is 
analyzed 
“Analyzing 
Binary” 
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Set up Profile Configuration 4 
ª  Select the Common tab 
ª  Check the Generate unique filenames checkbox 

ª  Adds job PID to performance output filenames 
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Profile Configuration: HPM 1 
ª  Select HPM tab 

ª  Check what points to 
instrument 
ª  By function 
ª  By callsite 

ª  Be selective to  
reduce overhead 
 

ª  Example: select 
ª  Function body 

ª calc.c 
ª time.c 
ª tstep.c 
 
 

  

Scroll to 
select 
more 
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Profile Configuration: HPM 2 
ª  Select Derived Metric Name (e.g. MIPS) 
ª  Select Generate visualization files 
ª  Select Profile button  

to run the profile  
analysis 
 

ª  Program is 
instrumented 
then 
executed 
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View HPM Performance Data 
ª  Popup appears after 

application runs, click 
Yes  to open viz files 

ª  HPCT Perspective with  
Performance Data view 
opens 

ª  Make sure performance 
data files are selected 
ª  Can select files with click, 

shift-click, ctrl-click 
ª  Deselect task 0 to get 

compute data info 
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View HPM Performance Data 2 

Open the Performance 
Data Summary view 

ª  When viewing multiple 
tasks 
ª  Right click on any 

entry in 
Performance Data 
Summary view 

ª  Select Show Data 
for Other Rank 

ª  Select task/pid from 
dropdown and click 
OK 
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View HPM Performance Data 3 
ª  To view additional 

metrics 
ª  Select instrumentation 

point in Performance 
Data Summary view 

ª  Right click 
instrumentation point 

ª  Select Show Metric 
Browser view 

ª  The Metric Browser 
view opens 
ª  Shows data for all tasks 
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View HPM Performance Data 4 
ª  Pick sort column by selecting column title 
ª  To add or delete visible metrics 

ª  Right click in Metric Browser view 
ª  Select Show Other Metrics 
ª Hide or show metrics using Filter Dialog 
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View HPM Performance Data 5 
ª  To show all data for all 

tasks in a table 
ª  Right click in 

Performance Data 
Summary view 

ª  Select Show Data as 
a Flat Table 

ª  Performance Data 
Detail view opens 

ª  Sort data by clicking 
desired table column 
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Re-opening Performance Data 
ª  To re-open Performance Data files: 
ª  Select Project Explorer view 
ª  Select one or more data (.viz) files 
ª  Right click over selected files 
ª  Click HPCT in popup menu 
ª  Click Open performance files in second menu 
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MPI Profiling and Tracing 
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Lab Exercise Note 
ª  For the hardware performance counter exercise m and n = 

512 in decs.h to get useful event counts and times 
ª  Change m and n to 8 in decs.h and rebuild shallow to 

reduce trace size to a manageable level 
ª m,n = 32 is ok 
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Collect MPI Data 
ª  Open Profile Configuration dialog 
ª  Example: Reuse profile configuration created for hardware performance counters 

ª  To remove HPM info: HPM tab, uncheck Function Body & reset DRM “MIPS” to blank and reset ‘generate vis. Files’ 
ª  Or can copy profile configuration to keep both configs 

ª  Same setup as hardware performance counters except you select MPI in 
Performance Analysis tab of profile configuration 
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Collect MPI Data (2) 
ª  Select MPI tab 
ª  Select instrumentation points 

ª  By call site 
ª  Select checkbox to 

instrument this point 
ª  Be selective to reduce overhead 

 

ª  For example: 
ª  Within neighbour_receive 
ª  Select MPI_Recv_## 
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Collect MPI Data 3 
ª Check Output trace for all tasks 
ª Check Trace all MPI calls 

ª  Select Profile to run the  
profile analysis 
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View MPI Profile Data 
ª  Performance Data 

Summary view opens 
automatically 

ª  Works similarly to viewing 
hardware performance 
counter data 
ª  Right click in view to open 

metric browser, show flat 
table, view different task’s 
data 

ª  Right click somewhere in 
Performance Data 
Summary view  

ª  Select Load MPI Trace in 
popup menu 

ª  Select path to save trace file 
on local system 
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View MPI Trace Data 
ª  Timeline view of MPI function calls 
ª  MPI Function calls color coded matching list of right 
ª  Exclude functions from trace by clicking checkboxes 
ª  Zoom in and out using buttons in title bar 
ª  Right click on an event box to see details for that event 
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In Summary 
ª Set of performance tools integrated with 

Eclipse and PTP 
ª Hardware performance counter profiling 
ª MPI profiling and tracing 
ª OpenMP profiling 
ª I/O profiling and tracing 

ª Application CPU time profiling 
ª Binary instrumentation tools 
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IBM Parallel Debugger  
n  Objectives 

¨  Introduce the IBM Parallel Debugger 
¨  Learn how to use the debugger features 

n  Contents 
¨  Overview of debugger architecture and features 
¨  Lab #1: Scavenger Hunt 
¨  Lab #2: Shallow 
¨  Lab #3: Sample Sort 
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DARPA Challenge 

n  IBM’s PERCS 
¨  Productivity, ease-of-use 
¨  Debug applications executing at Petascale 
¨  Conventional 'serial' debug overwhelmed 
 

“Debugging code on a parallel machine with hundreds or 
thousands of cores creates unique problems, and may 
be the biggest single challenge facing parallel 
programming” 
- Charles Holland [DARPA], The Economist, June 2011 
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About IBM ParDeb 

n  Utilizes mature serial debug engine technology 
¨  idebug +15 years in development 

n  Parallel Group Debug Infrastructure (PGDI) 
¨ Tree topology for efficient aggregation/filtering 

n  Customized for programming models 
¨ MPI, UPC, X10, openMP 

n  Efficient use of UI resources (pixels, mem, etc.) 
n  Emphasis on grouping 
 

Debug-2 



IBM Parallel Debugger 

Parallel Debugger Architecture 
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Debugger Execution Environment 

1. Client launches debug 
session 

2. Proxy launches 
application and root 
debug agent 

3. Root agent deploys 
PGDI 

4. One leaf agent per OS 
image attaches to 
application processes 

PGDI = Parallel Group Debug Infrastructure Debug-4 
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Debugging at Petascale (1/2) 

n  1,000,000 (1M) execution threads 
¨ How can they be represented in the UI? 
¨ How can the user operate on them? 

n  Need to be able to operate on a subset of threads 
¨ How can the user find the defect? 

n  Not practical to examine each thread one by one 
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Debugging at Petascale (2/2) 

n Organizing the threads into groups 
¨ Based on common characteristics of thread 

state and data 
¨ Can’t be done manually 
¨ What about thread state and data changes? 
¨ This only works if the debugger does all the 

heavy lifting 

Debug	
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Debug Groups 
n  Debug groups are dynamic collections of user threads 
n  All threads belong to at least one group, 
n  Threads join and leave groups as session progresses 
n  Group types 

¨  ALL – all user threads 
¨  Debug state – application states (e.g. SUSPENDED) 
¨  Function location – suspended in a function or method 
¨  Line location – suspended on a line in a source file 
¨  Breakpoint – suspended on a breakpoint 
¨  Stack – threads that share a similar call stack 
¨  Expression – threads with common data property 
¨  Distribution – threads with a variable within a certain range 
¨  Static – copy of some other group, membership never changes 
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Scalable Group Synthesis (1/4) 

Suspended (61)

Running (39)

(39)

(61)

Debug-8 

100 threads to manage

...

100 items

...
...

2 groups to manage manually

100 items

2 synthesized groups
(automatically classified)

2 items

Think about 
1M threads!!!

2 synthesized groups	


(automatically classified)	



2 groups managed manually	

100 threads to manage	
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Scalable Group Synthesis (2/4) 

Debug-9 

(39)

(61)

2 synthesized groups
(automatically classified)

2 items
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Scalable Group Synthesis (3/4) 
n  Groups are synthesized by applying a set of conditions 

to an existing group 
¨  GroupALL and Suspended => GroupSuspended 
¨  GroupALL and Running => GroupRunning  

n  Members join/leave groups dynamically 
n  Membership is not enumerated 

¨  PGDI encodes membership during synthesis 
¨  Group representative available to UI 

n  Billions of groups can be reserved 
¨  Light weight 
¨  Group vectors/arrays  
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Scalable Group Synthesis (4/4) 

n Problem investigation strategies 
¨ Divide and conquer 
¨ Odd man out 
¨ Outliers 
¨ Etc... 
¨ Can be applied in combination 
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Debug Perspective 
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Debug View 
n  Used to control groups of threads 
n  Debug actions operate on threads 

associated with selected group 
n  Group name indicates type 

n  Number of threads in group is shown in 
[ ]’s 

n  Focused member section shows stack 
frame of representative from selected 
group 

n  Group selection drives 
¨  Source View 
¨  Parallel Stacks View 
¨  Variables View 
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IBM Parallel Debugger 

Source/Editor View 
n  Synchronized with debug view 
n  Left Margin 

¨  Breakpoint markers 
¨  Execution context markers 

n  Right Margin 
¨  File level execution markers 

n  Line highlighting for suspended 
threads 
¨  Orange shading 

n  Active thread(s) selected in Debug 
view 

¨  Blue dashed box 
n  Active thread(s) not selected in 

Debug view 
¨  Green shading 

n  Thread(s) selected in Focused 
Member section 
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IBM Parallel Debugger 

Parallel Stacks View 
n  Shows merged call stacks for the group selected in the Debug view 
n  Works with debug control actions to step or resume threads 
n  Toggle function level or line level comparison 
n  Toggle to select call hierarchy order 
n  Stack selection drives 

¨  Source View 
¨  Group Details View 
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IBM Parallel Debugger 

Variables View 
n  Displays variables from 

representative member of 
selected group 

n  Shows variable value and type 
information (if available) 

n  Yellow highlight when value is 
modified during execution 

n  Value can be edited, changes will 
be reflected when execution 
continues 

n  Data structures are represented 
using hierarchical tree format 

n  Variable values can be auto-
refreshed at regular intervals 
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IBM Parallel Debugger 

Parallel Debug Groups View 
n  Acts as a clipboard area 
n  Interesting groups can be saved and monitored during a debug 

session 
n  Right-click on group in debug view and select Save Group 

¨  Will place group in Parallel Debug Groups view 
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IBM Parallel Debugger 

Data Elements View 
n  Used to retrieve a number of 

specific data values from a large set 
of data elements 

n  Data elements can be 
¨  Scalar local variables 
¨  Scalar elements of shared or local 

array 
n  Elements are retrieved from all 

suspended threads that have the 
variable in scope 
¨  Value matches value range 

n  Application must be built with FD2 
Debug Extensions 
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IBM Parallel Debugger 

Data Distributions View 
n  Histogram of data element values 
n  Each bar corresponds to value sub-

range 
¨  Length of bar represents number of 

elements in range 
n  Upper and lower bounds can be 

calculated automatically or specified 
manually 

n  Distributions can be created on 
¨  Scalar local variables 
¨  Scalar elements of a shared or local 

array 
n  Requires application built with FD2 

Debug Extensions 
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IBM Parallel Debugger 

Parallel Group Debug 
Configuration 
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IBM Parallel Debugger 

Lab #1 – Scavenger Hunt 
n  Parallel debug perspective 
n  Debug view 

¨ Groups (ALL, Suspended, Function, Line) 
¨ Focused Member 

n  Group representative's call stack 
¨ Debug controls (resume, step into, step over, 

etc...) 
¨ Breakpoints 
¨ Selection drives content of other views such as 

n  Source view, Variables view, Parallel stacks view, etc... 

Debug-21 



IBM Parallel Debugger 

Lab #2 - Shallow 

n  Debug an MPI application 
¨ MPI Debug Library 
¨ MPI Error Handling 

n  Reinforce basic debug skill set 
¨ Breakpoints 
¨ Stepping (step into, step over, step return) 

n  Debug, code, build cycle 
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IBM Parallel Debugger 

Lab #3 – Sample  Sort 

n  Debug a UPC application 
¨ View shared variables 
¨ Use of UPC Barrierpoints 

n  Diagnose errors 
¨ Program doesn’t run to completion 
¨ Determine cause and resolve through basic and 

advanced debugging features 
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Other Tools and Wrap-up 

ª Objective 
ª How to find more information on PTP 
ª Learn about other tools related to PTP 
ª See PTP upcoming features 

ª Contents 
ª Links to other tools, including performance tools 
ª Planned features for new versions of PTP 
ª Additional documentation 
ª How to get involved 
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Useful Eclipse Tools 

ª  Linux Tools (autotools, valgrind, Oprofile, Gprof) 
ª  http://eclipse.org/linuxtools 

ª  Python 
ª  http://pydev.org 

ª  Ruby 
ª  http://www.aptana.com/products/radrails 

ª  Perl 
ª  http://www.epic-ide.org 

ª  Git 
ª  http://www.eclipse.org/egit 

ª  VI bindings 
ª  Vrapper (open source) - http://vrapper.sourceforge.net 
ª  viPlugin (commercial) - http://www.viplugin.com 
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Online Information 

ª  IBM PE Developer Edition 
ª  http://ibm.co/tdM7QD 

ª  Information about PTP 
ª Main web site for downloads, documentation, etc. 

ª http://eclipse.org/ptp 
ª Developers’ wiki for designs, planning, meetings, etc. 

ª http://wiki.eclipse.org/PTP 
ª  Articles and other documents 

ª http://wiki.eclipse.org/PTP/articles 
 

ª  Information about Photran 
ª Main web site for downloads, documentation, etc. 

ª http://eclipse.org/photran 
ª  User’s manuals 

ª http://wiki.eclipse.org/PTP/photran/documentation 
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Mailing Lists 

ª  PTP Mailing lists 
ª Major announcements (new releases, etc.) - low volume 

ª http://dev.eclipse.org/mailman/listinfo/ptp-announce 
ª  User discussion and queries - medium volume 

ª http://dev.eclipse.org/mailman/listinfo/ptp-user 
ª Developer discussions - high volume 

ª http://dev.eclipse.org/mailman/listinfo/ptp-dev 

ª  Photran Mailing lists 
ª  User discussion and queries 

ª  http://dev.eclipse.org/mailman/listinfo/photran 
ª Developer discussions – 

ª  http://dev.eclipse.org/mailman/listinfo/photran-dev 
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Getting Involved 

ª See http://eclipse.org/ptp 
ª Read the developer documentation on the wiki 
ª Join the mailing lists 
ª Attend the monthly developer meetings 

ª Teleconference Monthly 
ª Each second Tuesday, 1:00 pm ET 
ª Details on the PTP wiki 

ª Attend the montly user meetings 
ª Teleconference Monthly 
ª Each 4th Wednesday, 1:00 pm ET 
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Thanks for attending 
We hope you found it useful	



PTP Tutorial Feedback 

ª Please complete feedback form 
ª Your feedback is valuable! 
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